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To mitigate the adverse effects of elevated temperatures, conventional rigid devices use bulky radiators, heat sinks and
fans to dissipate heat from sensitive components. Unfortunately, these thermoregulation strategies are incompatible with
soft robots, a growing field of technology that, like biology, builds compliant and highly deformable bodies from soft
materials to enable functional adaptability. Here, we design fluidic elastomer actuators that autonomically perspire at
elevated temperatures. This strategy incurs operational penalties (i.e., decreased actuation efficiency and loss of
hydraulic fluid) but provides for thermoregulation in soft systems. In this bioinspired approach, we 3D-print finger-like
actuators from smart gels with embedded micropores that autonomically dilate and contract in response to temperature.
During high temperature operation, the internal hydraulic fluid flows through the dilated pores, absorbs heat and
vaporizes. Upon cooling, the pores contract to restrict fluid loss and restore operation. To assess the thermoregulatory
performance, this protocol uses non-invasive thermography to measure the local temperatures of the robot under varied
conditions. A mathematical model based on Newton’s Law of Cooling quantifies the cooling performance and enables
comparison between competing designs. Fabrication of the sweating actuator usually takes 3-6 h, depending on size, and
can provide >100 W/kg of additional cooling capacity.

Introduction

Bioinspiration translates desirable features from natural systems into designs for use in engineered
systems'. Recently, roboticists developed the materials and manufacturing tools to create robots that
replicate the soft tissue systems found in biology”. Constructed from soft elastomers, these ‘soft
robots’ mimic animal functions (adaptive locomotion, camouflage, adhesion, sensing and autonomy)
that are not possible with conventional rigid robotics’ . Unfortunately, encasing robotic components
within elastomeric bodies creates new challenges®. In particular, polymers typically possess thermal
conductivity that is orders of magnitude below that of ceramics and metals. Thus, to operate at peak
power outputs for extended periods of time, soft robots need to employ thermoregulation.

The thermal energy of a body is a measure of its kinetic energy at the molecular scale. These
molecular motions govern the observed mechanical, electrical and chemical behavior of matter.
Consequently, many systems, both biological and engineered, actively thermoregulate to maintain
performance within an acceptable range. The immutable laws of thermodynamics relate heat flow to
the work done by a system. A corollary of these laws precludes the existence of perpetual motion
machines; the conversion of stored potential energy into useful work cannot be 100% efficient; some
remainder is always lost as heat. Hence, work output, and its associated heat production, must be
adequately offset by thermal dissipation to avoid the adverse effects of increased temperature’. This
challenge is particularly compelling when considering the current use of soft robotic power systems
that release significant amounts of energy (fluidic compression, exothermic reactions of peroxides and
combustion of fuel) necessary for rapid, high-powered actuation®™''. Beyond endogenous thermal
stress related to power output, soft robots may operate in extreme environments (e.g., temperature,
radiation or toxic atmosphere) that are unsafe for living beings'>"'*. In these harsh conditions,
thermoregulation is necessary to execute tasks without failure of the robotic subcomponents.

Animals dissipate thermal energy from their bodies to balance heat generated from their basic
metabolism and activity levels. While the specific thermoregulatory strategies can be anatomical,
behavioral or physiological in origin, animals use four modes of heat dissipation: radiation, conduction,
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convection and evaporation. Thermal radiation occurs in all bodies above absolute zero and scales both
with temperature to the fourth power and surface area. Because metabolic production scales with mass,
radiation is most dominant in small organisms with large surface area—to-volume ratios—larger animals
must also use other modes'”. Behaviorally, animals seek out contact with cold surfaces to conduct away
heat. Alternatively, convection is heat transfer mediated by a mobile fluid phase (gas or liquid) near the
interface of a body. Evolutionary biologists propose that the anatomical plates in Stegosaurus increased
convective losses by as much as 50%, and the synergistic effect of vasodilation and ear flapping dissipate
20-50% of the total metabolic heat in elephants through convection'®'"”. Similarly, soft robots based on
fluidic elastomer actuators can utilize the circulation of pressurizing fluid to enhance heat exchange'®"”.
However, as first suggested in Newton’s Law of Cooling”’, the rate of heat dissipation for conduction
and convection depend on the temperature difference between the body and its environment. As such,
these mechanisms cannot cool a body below environmental temperature, and their efficacy relies
heavily on changing terrestrial conditions. Thus, many land-animal systems use the fourth mode—
evaporative water loss (EWL)—to effectively lower temperatures below ambient.

Numerous evolutionary adaptations capitalize on the ubiquity and thermodynamic properties of water
for evaporative cooling. Liquid water molecules must absorb significant body heat during vaporization
(enthalpy of vaporization: ~40 kJ/mol). Canids adopt rapid, shallow breathing patterns to increase
respiratory EWL (REWL) from moist nasal and mouth cavities”'. Inefficiently, the muscle contractions
required for increased respiration also simultaneously increase heat production” ", In another adapta-
tion, domestic pigs can further enhance their cooling capacity from 40 W/m? (REWL) to up to 800 W/m”
by wallowing in mud to trigger cutaneous EWL (CEWL)”. When access to pools of water is limited, other
mammals promote CEWL physiologically by sweating. The exceptional endurance of horses and humans
can be attributed, in part, to their unique capacity for perspiration. Widely distributed networks of sweat
glands in these animal systems provide for rapid perspiration and consequently over 20 W/kg of cooling
capacity””~*’. It is important to note that EWL does incur penalties to the organism. Animals need access
to sources of aqueous fluids to drink or otherwise replenish lost water®'.

Although previous research used hydrogels (i.e., sponge-like polymer microstructures filled with
water) to absorb large amounts of heat, these devices were unable to actively secrete sweat to their
surface for vaporization'**’. The first robotic example of bioinspired perspiration is Kengoro®"**.
This humanoid system pumps water through its porous, laser-sintered aluminum skeleton to realize
sweating-enhanced performance. In a feat of endurance, the robot did push-up exercises for 11 min
without catastrophic thermal failure of the motors. Yet, unlike animal systems, Kengoro’s pore
dimensions are static, and the source of the fluid is a separate, dedicated hydraulic circuit. By
comparison, humans exhibit focal hidrosis, where sweat glands use fluid from the blood to secrete
perspiration through temporarily dilated pores. We implemented these biological paradigms by 3D-
printing a porous soft-bodied actuator that autonomically (i.e., without external control) perspires’”.
At low temperatures, microscale openings in the polyacrylamide dorsal layer of the actuator remain
sufficiently small to allow for hydraulic pressurization and actuation. As temperatures rise above
~40 °C, the poly-n-isopropylacrylamide (PNIPAm)-based body collapses as the pores simultaneously
dilate to expel the pressurizing fluid from the internal volume. Although this design results in
decreased actuation efficiency (i.e., the actuation angle decreases by ~30° with pores), the thermo-
dynamically driven response is reversible. With sufficient evaporative cooling, the rate of water loss
will drop as the robotic body cools and the hydrogel networks return to their original conformations.

In our embodiment, the actuating liquid also serves as our perspiration. This strategy combines
power transmission with thermoregulation to reduce design complexity and system mass. However,
this motif introduces a trade-off in the performance of the robot—water lost as sweat cannot be used
for actuation. Untethered operation of the robot requires accounting for these losses or a means of
refilling water stores. In addition, as mentioned above, not all sweat is productive; some liquid
inevitably falls off the body on to its surroundings. Although this water loss does not cool the robotic
hand itself, we demonstrate the ability to thermo-manipulate items by transmitting perspiration
across interfaces. This vaporization, combined with conductive heat transfer to the robotic hand,
improved the cooling rate of manipulated objects by >200%"".

Development of the protocol

Materials design and manufacture of an autonomic perspiring hydrogel actuator

Synthetic hydrogels (i.e., hydrophilic polymer networks) are used frequently in bioinspired sys-
tems”**”. Two classes of hydrogel actuators are common in soft robotics: fluidic elastomer actuators
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Fig. 1| Bioinspired 3D-printed hydrogel actuator. a, High-surface-area design actuator with multimaterial printing. b, Exploded view of actuator design.
¢, Comparison between pore response and actuator behavior when hydraulically pressurized in different environments. d, Actual image of a sweating
actuator before and after pressurization. PNIPAm, poly-n-isopropylacrylamide. Portions of this figure are reproduced with permission from re

(FEAs) and osmotic actuators’®. Fluidic actuators operate like patterned balloons; during pressur-
ization of internal channels, the elastomeric body changes shape depending on the architectural
arrangement of strain-limiting elements (Fig. la). By comparison, osmotically driven ‘smart’
hydrogels reversibly absorb large amounts of solvent directly into the polymer network to change
their volume multiple times in response to subtle environmental changes. The energetic balance
between the chemical potential energy of the mixture (solvent-polymer system) and the elastic
potential energy of the network governs this dynamic behavior’”’*, When the solvent-gel interaction
is favorable, solvent molecules diffuse down the chemical potential gradient to swell the polymer until
equilibrating with the elastic potential of the stretched network. If the interaction is unfavorable, the
elastic energy dominates, and the gel expels solvent molecules and collapses. In general, FEAs, though
more energetically demanding and less efficient, provide for more rapid (f > 1 Hz), large-scale, high-
force actuation when compared to smart gels™. Thus, our design incorporates hydraulically driven
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FEAs capped by hydrogel layers containing osmotically driven micropores.

In our strategy for autonomic thermoregulation, we require multimaterial fabrication from two
hydrogel materials with disparate responses to elevated temperatures. By building the dermal layer
from a thermally expanding hydrogel (polyacrylamide (PAAm) based), pore diameters will expand
with temperature. For the strain-limiting actuator body, we use a thermally contracting material
(poly-n-isopropylacrylamide (PNIPAm) based), which results in a decrease in the volume of internal
fluidic pathways at elevated temperatures. As shown in Fig. 1b,c, these opposing material responses
combine to minimize water loss at low temperatures but promote perspiration at elevated tem-
peratures. The Laplace pressure (AP;) describes the pressure differential sustained by surface tension
(9) at a liquid-gas interface of known geometry (defined by contact angle, g, and pore diameter, d). At
low temperatures and small pore diameters, the surface tension is sufficient to oppose the applied
pressure during fluidic actuation (AP,). At elevated temperatures, the pores dilate and the actuator
body simultaneously collapses to increase AP4. Eventually, the surface tension within the pore fails to
balance this internal pressure (AP, > AP;), water flows onto the skin’s surface and the robotic system
increases CEWL. We note that perspiration occurs at the expense of actuation efficiency; water losses
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continue until AP, drops to equilibrate with AP;. Our use of dynamic pores as ‘gates’ or sphincters is
a fundamentally different mechanism than biological perspiration. In human sweat glands, the
contraction of myoepithelial cells that surround the secretory coil aid in driving perspiration through
ducts to pores on the skin’s surface.

We 3D-print our bioinspired actuators by using acrylate-based photopolymer inks and stereo-
lithography (SLA). A form of vat polymerization, SLA (also known as digital light processing) systems
project a series of photopatterns into liquid photopolymers to create solid objects, layer by layer.
Acrylate monomers with different side groups can still copolymerize into a single network;
exchanging the composition of the acrylate resin between illumination steps permits robust multi-
material construction””*'. In SLA, the buoyant support provided by the liquid resin and the high
spatial-temporal resolution of light enable printing of soft matter with overhanging geometries
desirable in FEAs*>*, For autonomic perspiration, the ability to obtain porous features on the order
of hundreds of microns is particularly powerful. As AP; is inversely proportional to droplet diameter,
not only can small pores sustain the largest actuation pressures without sweating, but high surface
area—to-volume ratios promote rapid shape change in smart gels*'. In addition, we print micron-scale
texture on the outer surface to promote ‘wetting out’ to further enhance CEWL.

Measurement of evaporative cooling capacity

Comparative physiology has a rich history classifying the thermal behavior of animal systems dating
back to John Hunter’s eighteenth-century distinction between ‘warm-blooded’ and ‘cold-blooded’
animals™’, Since then, numerous studies focused on the role of EWL by tracking the water man-
agement as a function of thermal stress. Researchers monitor both water intake (water in food,
drinking water and oxidation water) and losses (feces, urine and and respiration)45. For small, non-
sweating species, standard procedure involves confinement of animals in an enclosed environment
under constant air flow. Non-EWLs (e.g., from animal waste) are avoided by coating the bottom
surface of the enclosure in oil; experimental protocols then attribute the difference between humidity
at the inlet and outlet solely to EWL. For large animals in open environments, REWL is not directly
measured but crudely estimated on the basis of extrapolations of short-term respiration rates or local
dew point hygrometry. For horses and humans, which exhibit large capacities for perspiration,
researchers use direct sweat collection or simply track total weight loss (with metabolic losses esti-
mated via respiration) during exercise*>*’. However, such methodologies based on EWL probably
overestimate the actual cooling performance due to perspiration. In practice, some sweat will
inevitably fall off the body before evaporation, particularly during movement.

As an alternative, we developed a protocol that uses thermography to track surface temperatures
and, by extension, heat transfer. As mentioned above, all objects radiate energy proportional to the
fourth power of the absolute temperature. IR cameras are sensitive to the spectrum of light that
corresponds to this thermal electromagnetic radiation (1 um < A < 14 pm). IR cameras are now widely
available for civilian use at low cost and in handheld form factors. Although capabilities (e.g., field of
view, resolution and refresh rate) vary widely with price, the basic operation of thermal cameras is
nearly identical to that of popular digital cameras—point and click. The ease in operation and non-
invasive, rapid acquisition of local temperatures for large areas makes thermography particularly
attractive for soft systems, as traditional rigid sensors (resistive temperature detectors or thermo-
couples) distributed about the surface can become burdensome and alter the operational behavior of
the robot.

Still, there are limits to thermographic imaging. We estimate that the emissivity of our materials
remains constant at € ~0.9, an assumption that holds for most polymers and biological materials but
is often not true for highly reflective metal surfaces. When this assumption is not valid, applications
of surface coatings (e.g., black paint) reduce reflectivity, or adjustments to the camera’s IR sensors
directly accommodate such differences in emissivity. There are also radiative issues with maintaining
high resolution under large temperature gradients; the resulting thermographs may overestimate the
size of ‘hot spots’. Thus, an appropriate camera with sufficient specifications including frame rate,
responsivity, noise-equivalent temperature difference, spectral band, minimum resolvable tempera-
ture difference and dynamic range is necessary. Unfortunately, the highest-performing cameras are
not only expensive but potentially restricted under the International Traffic in Arms Regulations for
their applications in weapons systems48.

Ultimately, this time-dependent thermography data, when used in conjunction with known
material parameters, permits modeling of heat transfer in the system (see the procedure for more
detail, including the relevant equations). Yet, the problem persists for isolating the contributions from
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Table 1 | Printing parameter selection

Modification Advantages Disadvantages

Increase [AAm] Increases gel strength Increases onset temperature of gel
collapse (actuator body material)

Increases solubility in water Unreacted monomers require extraction
after printing

Increase [NIPAmM] Decreases onset temperature of gel Decreases solubility in water
collapse (actuator body material)

Decreases gel strength

Unreacted monomers require extraction
after printing

Increase [MBA] Decreases gelation time Increases stiffness
Decreases swelling ratio
Decreases elongation at break

Increase [riboflavin] Decreases gelation time Decreases resin stability

Increase [hydroquinone] Increases resin stability Increases gelation time

Increase [water] Decreases viscosity of resin Increases gelation time
Decreases stiffness Decreases strength

perspiration and evaporation from the other heat transfer modes, particularly convection. Traditional
experiments minimize convective losses by making the measurement under vacuum, a situation
which is not representative of terrestrial conditions. Instead, our protocol simply conducts mea-
surements for equivalent systems under different conditions (e.g., sweating and non-sweating and
free and forced convection), models the temperature drop according to Newton’s Law of Cooling and
infers the contributions from the different modes by the comparative performance. In addition,
although we focus on heat dissipation, our proposed procedure can also measure the heat generated
during active robotic operation.

Experimental design

Manufacturing and materials

Printing. Although there are now numerous commercial offerings for inexpensive desktop SLA
printers, we chose an Autodesk Ember. This system contains a LED-based UV (A = 405 nm)
projector with an irradiative power, H,, of ~22.5 mW/cm” for 1,280 by 800 pixels that cover a 64 mm
by 40 mm build area.

Chemistry. Designing a 3D-printable hydrogel chemistry for autonomic perspiration requires bal-
ancing numerous engineering trade-offs in processability, mechanical performance and dynamic
response. In simple formulations, these resins usually contain photopolymerizable monomers
(acrylates; e.g., acrylamide (AAm) and N-isopropylacrylamide (NIPAm)), multifunctional cross-
linking species (e.g., N,N’-methylene-bisacrylamide (MBA)), a photo-initiating system (riboflavin and
triethanolamine (TEOHA)), a radical stabilizer (hydroquinone) and a suitable solvent for all com-
ponents (water). However, the selection and relative amounts of these components can drastically
alter performance as shown in Table 1. For example, increasing the amount of crosslinker enables
rapid gelation during printing, but the increased crosslink density also makes the resulting polymer
more brittle and reduces the dynamic swelling response.

Resin formulation is often an iterative process that should incorporate considerations from the
mechanical design (i.e., target resolution specifications) and performance of the printed object (ie.,
ultimate strain during operation). Table 2 shows a representative formulation of AAm- and NIPAm-
based resins described in previous work®’.

Characterizing the dynamic response of the hydrogel

When designing sweating machines based on smart hydrogels, an understanding of the underlying
dynamic response of the material is critical. Hydrogel swelling is governed by a thermodynamic
balance between the solvent-polymer interaction that promotes swelling and the elastic energy of the
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Table 2 | Representative recipes for 3D-printable hydrogel resins

AAm-based resin (dorsal layer) NIPAm-based resin (body of Units

actuator)
25 3.5 g AAm
0 17 g NIPAm
0.542 0.33 g MBA
0.2 0.2 ml of hydroquinone solution (1 mg/ml
H,0)
30 33.5° ml H,O
0.2 0.2 ml of riboflavin solution (1 mg/ml H,O)
1.8 1.8 ml of TEOHA solution (0.3 g/ml H,0)

“When adding dye or nanoparticles, decrease the amount of water to maintain a consistent total volume.

polymer network that favors collapse. As such, the swelling behavior changes drastically based on the
solvent composition and temperature. In addition, swelling is mediated by the diffusion of solvent
from the surroundings across the polymer-solvent interface; there is a strong dependence on swelling
kinetics and the hydrogel surface-to-volume ratio (SA:V). Thus, one needs to conduct time-
dependent swelling experiments across various experimental conditions that replicate likely envir-
onmental ones. We quantify the degree of swelling in terms of mass (gravimetric) and dimensional
change (direct imaging), both involving simple methods accessible to researchers with an
undergraduate level of training. Appropriate planning can enable simultaneous collection of the two
data streams.

Comparative analysis of cooling capacity

In real world operating conditions, the sweating actuators not only shed heat by vaporizing water but
also passively cool via radiative, conductive and convective losses. Beyond being a conventional heat
transfer mode, convective air currents can also enhance EWL by decreasing the vapor pressure
(Bernoulli’s effect) and reducing relative humidity immediately above the surface. Thus, the rate of
evaporation, and thereby the cooling capacity of a sweating robot, depends greatly on the local
motion of air. Unfortunately, ‘free convection’ occurs naturally in terrestrial environments as a result
of temperature gradients; warm gases near the hot surface become less dense and rise to create
currents. This phenomenon is dependent on both the motion and the geometry of the body, which
limits the utility of comparing the performance of sweating robots. As an alternative, we suggest
experimentally creating a sufficient ‘forced convection’, which dominates the intractable contribution
from ‘free convection’. To further isolate the vaporization of sweat, we also recommend conducting
numerous comparative cooling experiments, particularly comparing the results from sweating robots
and their non-sweating counterparts. Among these numerous experiments, the change in body
temperatures as a function of time can be fit to a first-order differential based on Newton’s Law of
Cooling and quantified by using a lumped parameter analysis. Refer to the procedure for more
information.

Modifying the procedure to improve performance

Opportunities to improve thermoregulatory performance exist by using pressurizing fluids beyond
pure water. For example, salts or other ions can be used to modulate both the heat of vaporization
and the boiling point. The use of organic solvents may also lower the boiling point to enhance low-
temperature evaporation and thereby maintain a lower body temperature. However, such mod-
ifications may also alter hydrogel swelling behavior and thereby pore dilation and contraction. In
addition, the thermodynamic calculations need to include the composition-dependent enthalpy of the
vaporization.

Soft robots operating in diverse environmental conditions will need to thermoregulate to offset
heat generated during periods of high-power output. Similar to animal systems, autonomic per-
spiration offers a means to rapidly cool body temperature in simple polymeric actuators. We envision
a future in which robots attain a higher autonomy, and we expect these advances to require devices
with more sophisticated forms that exceed the simple manifestation above. For example, vertebrates
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are composed of both stiff skeletons and soft tissues that enable load bearing activities and high force
generation, tasks that remain difficult for conventional soft hydrogel actuators. Future robots may use
a thin perspiring hydrogel skin that encapsulates more robust components. In addition, our multi-
functional design uses the actuating fluid as the perspiration, which reduces design complexity and
weight but incurs obvious penalties: sweating requires some actuation pressure, and actuation effi-
ciency decreases as the pores dilate. We propose an alternative strategy where a dedicated micro-

Materials

fluidic system for sweating is 3D-printed on top of the hydraulic system for actuation. Regardless of

the design and manufacturing specifics, this protocol provides guidelines for quickly measuring
surface temperature and develops a mathematical model for evaluating the thermoregulatory

performance among competing systems.

Procedure

Reagents

° AAm (Sigma-Aldrich, cat. no. A9099)

¢ NIPAm (Sigma-Aldrich, cat. no. 731129)

* MBA (Sigma-Aldrich, cat. no. 146072)

e TEOHA (>99%; Neta Scientific, cat. no. OAK-242387)

¢ Hydroquinone (99%; Sigma-Aldrich, cat. no. H9003)

¢ Riboflavin (>99%; Neta Scientific, cat. no. OAK-21910)

¢ Deionized water

o (Optional) iron oxide nanoparticles (see previous work for synthesis)’”
e (Optional) Carbon urethane methacrylate

e Cyanoacrylate superglue (McMaster Carr, part no. 74765A63)

Equipment

e Autodesk Ember 3D printer

¢ (Optional) Carbon M1 printer

e Thermal camera (FLIR E4)

* DSLR camera (Canon EOS 80D, 24.2 megapixels)

¢ Hot plate (Corning PC420-D)

e Analytical balance (Mettler Toledo XPR3003S)

e Syringe pump (New Era Pump Systems Inc. NE-1000)
e Personal computer

e Tygon tubing (McMaster Carr, part no. 6516T11)

e Syringe with Luer lock (McMaster Carr, part nos. 7510A802 and 7510A807)
e Pressure sensor (0-100 PSI; Transducers Direct LLC, TDH30-CG-0100-03-D004)
e Multi-channel data-acquisition module (National Instruments USB 6501)

e Air circulator fan (Honeywell Inc. HT900)

¢ (Optional) Uni- and bidirectional adhesive tape (3M)
* (Optional) 20-ml glass vials

¢ 100- and 500-ml glass beakers

® Ruler

Software

e Autodesk Print Studio

¢ ImageJ1.X

e Dassault Systems SolidWorks 2018
¢ National Instruments LabVIEW

¢ FLIR Tools

e Mathworks MATLAB

Bioinspired actuator design

1 Design the FEA body in 3D modeling software. In our case, we used SolidWorks 2018. Although
the specifics of the design depend on application, conventional FEAs require an inlet, strain-
limiting elements and internal fluidic chambers. For our rectangular finger-like actuators, we start
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with an outer dimension of 60 mm x 16 mm X 17 mm (see Supplementary Fig. 1 for design
schematics and reference *° for design files).

For the inlet to couple with 3-mm tubing, create a 3-mm long cylindrical hole in the actuator with a
diameter of 2.59 mm. The soft body of the actuator can accommodate the wider tubing and enable
a frictional fit.

To maximize actuation amplitude while minimizing local strains, we incorporate five consecutive
fluidic chambers (internal volume of 5.5 mm x 14 mm x 12 mm) connected to this inlet. We
enclose each of these ‘bellows’ in a 2-mm thick wall. Each chamber is 1.5 mm apart; when inflated,
adjacent chambers expand, contact each other and promote bending.

A CRITICAL STEP To aid in printing the overhanging features of these chambers, we recommend
filleting the edges. We found a fillet diameter of 5.5 mm sufficient.

Our desired actuation mode replicates flexion of the finger. Thus, the ventral plane of the actuator
needs to be a strain-limiting element. We chose to incorporate a thicker (2-mm) layer of the
PNIPAm-based material to direct actuation.

A CRITICAL STEP For an actuator body composed of a single material, the thickness of the bending
plane should be greater than the actuator wall thickness.

In the design software, insert pores through the dorsal layer to the internal fluidic channels with the
desired size and shape. For our PAAm-based surface, we found that circular pores <100 microns in
diameter are desirable. At this scale, we observe fluidic actuation with minimal water loss when
closed at low temperatures, but sufficient pore dilation for perspiration at elevated temperatures
(see Characterizing the dynamic response of the hydrogel). To mitigate fluidic energy loss, we
recommend a low density of pores near the inlet. In practice, we placed one pore in the first
chamber, six pores in the final chamber and two pores in each of the intermediate bellows.

A CRITICAL STEP The pore shape, size and density in the actuator design affects printability,
autonomic thermal response and actuator efficiency. We conducted an iterative design-feedback
cycle that evaluated pore area change (see Characterization of smart materials for autonomic pores)
and actuation amplitude (see Mechanical performance of the actuator) as a function of
temperature.

? TROUBLESHOOTING

Add texture onto the actuator body to increase the cooling rate. On the basis of the designed
iteration (Supplementary Fig. 2), we selected the pyramid (isosceles triangle with a constant depth,
0.5-mm sides and 1-mm base; Fig. 1a) to increase total surface area by 16.7%.

A CRITICAL STEP We did not add extra material onto the actuator body; instead, we subtracted
material with the ,cut tool‘ and repeated this action with the linear pattern tool in SolidWorks. This
method reduces the thickness of the structure without compromising the structural stability. In
addition, while a finer texture would possess a greater SA:V ratio (1.32 times as much than without
texture), we found rough features <500 microns difficult to rapidly print.

Printing of polymeric devices (print times are proportional to object height, ~1 cm/h)

A CRITICAL The method described here is one option of many numerous potential strategies that could
result in a robotic system with autonomic sweating. Other manufacturing methods (direct ink writing,
ink jetting and molding) and other material chemistries may obtain similar performance. As such, the
following steps are not prescriptive but serve as a guide. Refer to Experimental design for more
information.

7

Prepare >50 ml of resin by combining all components (Table 2) until dissolved. To maximize
stability of the resin, store all chemicals at low temperature in opaque, sealed containers. For best
results, add the photoinitiator system (e.g., riboflavin and TEOHA) to the resin immediately before
use. Minimize ambient exposure to light by working quickly in a dark room. Resin preparation
should take <20 min for a single undergraduate researcher.

In an initial experiment, determine exposure settings for the materials by generating a ‘working
curve’ (i.e., cure depth versus exposure dosage)*’. Briefly, this experiment measures the height of
cured objects from single exposures of increasing time scales. We recommend placing a vat of resin
above your light source and exposing for different periods of time (e.g., 10-s intervals). After
exposure, remove the uncured resin and immediately determine the height of the solid material.
Because hydrogel materials are probably too soft to be practically measured with a caliper, we
recommend optical measurements of the height (see Pore dimensions via image analysis). Plot the
height of the object (or cure depth, C,) as a function of the log of the exposure dose (log H,).
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10

11

12

Extrapolate the exposure dosage necessary for the target layer height and use this value to guide the
‘exposure time’. For our system, we use 22 and 59 s of exposure for AAm- and NIPAm-based
materials (layer height = 250 pm), respectively.

Prepare the print file from the associated CAD file (.stl or .obj). In the printer’s software, align and
orient the design to minimize the total number of layers (a proxy for print time) and avoid abrupt
changes in cross-sectional area between layers, where possible. If necessary, add sacrificial
supporting structures as recommended by the software. In general, it is best to place a large, flat
area of the part directly on the build head to minimize the need for supports. Select a layer height
that is less than the minimum desired z-resolution. In our system, we chose a layer height of 250
microns. After defining the necessary parameters, export the print file to the printer. In our case,
Print Studio software (Autodesk) generates a zipped file (.tar.gz) that can be directly read by an
Autodesk Ember printer.

Pour the resin into the vat and begin printing. For multimaterial prints, determine when to pause
the print, raise the build stage and change the resin stock.

A CRITICAL STEP During resin replacement, reduce material contamination by removing all
unreacted liquid from the object and vat, and avoid introducing alignment issues that occur when
the build stage is shifted.

(Optional) For longer prints, it can be time consuming to continuously monitor print progress for
resin exchange at the appropriate layer. We recommend adding a ‘pause’ or ‘wait’ step to signal the
need for this material swap. The actual modifications will vary with the proprietary software. We
provide two examples of ways this can be done.

(A) Manual layer detection

(i) To increase the ‘wait’ time for the desired transition layer, extract the zipped (.tar.gz) print
file twice. In the resulting directory, there will be a series of images corresponding to each
sliced layer as well as a ‘printsettings.txt’ file.

(i) Add a ‘Tayersettings.csv’ file to this directory. The comma-separated values should contain
an initial heading row that starts with ‘Layer’ and then includes a cell with each ‘Model’
parameter from the printsettings.txt file.

(iii) In the next row, below ‘Layer’, enter the appropriate layer number for the material swap,
and below ‘ModelPressWaitMS$’, enter 60,000 to create a 60-s wait. Repeat as necessary in
other rows for additional layers, leaving all other cells unmodified.

(iv) After saving, select all files (slices, printsettings.txt and layersettings.csv), zip all files and
export to the Ember printer as before.

(v) During printing, there will now be a prolonged ‘wait” period of 1 min at the desired layer.
Press the ‘Pause’ button on the front of the printer. After the build stage rises from the vat,
swap the resin and press the ‘resume’ button. Repeat as necessary.

(B) Automatic layer detection

(i) Alternatively, to add a ‘pause’ at the desired layer, connect to the Ember printer by using
the USB port. Write a script that periodically checks the status of the printer by using
cURL, a free command line tool:

>curl -d “command=GETSTATUS” -X POST (http://192.168.7.2/command)
(ii) Have the script parse the output to get the layer number, and at the appropriate layer, the
script should issue a pause command:
>curl -d “command=PAUSE” -X POST (http://192.168.7.2/command)
The printer should now raise the build stage out of the vat and pause indefinitely until a
user presses the ‘resume’ button after exchanging the resin. Repeat as necessary.
If the print is successful, remove the object from the build stage. When not in use, store all hydrogel
objects in a sealed plastic bag to reduce water losses. If the print failed, identify the failure mode and
address the issue with changes to the print parameters or material resin.

Characterization of smart materials for autonomic pores ® Timing ~24 h
A CRITICAL The purpose of these steps is to find out how the hydrogel expands and contracts under
different environmental conditions.

We quantify the degree of swelling in terms of mass (gravimetric) and dimensional change (direct

imaging), both involving simple methods accessible to researchers with an undergraduate level of
training. Appropriate planning can enable simultaneous collection of the two data streams.
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13

14

15

16

17

18

Prepare hydrogel samples in a defined geometry that approximates the actuator dimensions
(pore dimension, layer thickness and SA:V ratio). We chose to fabricate rectangular prisms
(10 mm x 10 mm x 2 mm) with four holes (pores) through the thinnest dimension. The initial
shape and size of these pores can be varied as needed by simply altering the printed design.

A CRITICAL STEP The hydration state of hydrogels often changes under ambient conditions.
Minimize exposure to the atmosphere, by conducting measurements rapidly and, when possible,
store in an enclosed atmosphere (e.g., a plastic bag).

Immediately weigh the sample and take an image of all pores with a known scale to determine the
initial as-fabricated state. Micron-scaled pores may require a microscope or macro lens to resolve
all features. For recording mass, we recommend a precision balance with a sensitivity of <1 mg
(Mettler Toledo MS403S).

A CRITICAL STEP When using simple photography methods, include a reference object of known
length, preferably a ruler in the field of view. Adjust the lighting such that pores are clearly
resolvable in all images.

Place the sample in the desired environments. We selected pure water at temperatures from 20 °C
to 80 °C in 10 °C increments.

At defined times, remove the samples from the environment. Place the sample on a lint-free non-woven
wipe to remove any unbound solvent from the surface. Rotate the sample until all sides are dried.
Immediately after drying the sample, weigh the sample and take images (microscopy or
photography) of all pores with a known scale. Ensure that sample identification is either directly
evident in the image or present in the file’s metadata.

Repeat Steps 2-5 as needed. The spacing of time intervals can increase throughout the
measurement, because hydrogel swelling exhibits logarithmic behavior until equilibrium is reached
(often after 24 h).

A CRITICAL STEP Swollen hydrogels can be delicate. If the gel becomes damaged in any way during
manipulation, discard and repeat the measurement on a freshly fabricated sample.

Pore dimensions via image analysis

A CRITICAL There are numerous image processing software packages. Below, we provide the general
procedures for image analysis, but will focus on methods compatible with ImageJ1.X, a popular public
domain, open-architecture tool.

19
20

21
22

Collect all images as outlined in Characterization of smart materials for autonomic pores.

If unknown, determine the length scale of pixels. Although many microscopes have proprietary
software that converts pixels to distance, this feature is not available in common cameras. Using the
‘straight line’ tool, draw a line that connects two points separated by a known distance (e.g., 1 cm)
along the reference object (see above). Go to Analyze > Set Scale and enter the known length of this
line with a pixel aspect ratio of 1. This process will convert the pixels to dimensions of length.
Quantify the number of pixels within the pore area. For individual pores, this can be done
manually. With the freehand selection or elliptical selection tools, enclose the pore. Go to Analyze >
Measure (Ctrl4+-M) to obtain the measured pore area. For batch processing of multiple pores, it is
also possible to collect area data via thresholding. Go to Image > Adjust > Thresholding and adjust
the histogram until fully selecting all pores in the original image. Apply the threshold to convert the
image into black and white. Next, select Analyze > Analyze Particles, which returns the measured
areas for all identified pores.

Repeat measurements to collect data for a statistically significant number of pores (at a minimum, 7 > 7).
These measurements yield the kinetics of hydrogel response under varying conditions. In ideal
autonomic perspiration, the smart material has pores that rapidly dilate at elevated temperatures
but remain sufficiently closed at desired operating conditions. Modify the material composition
and/or pore design until these targets are met.

Mechanical performance of the actuator

A CRITICAL For unidirectional finger-like FEAs, it is useful to characterize the bending angle as a
function of actuation pressure (or volume). More advanced actuation systems (i.e., multimodal
actuators) will probably require modifications to this protocol and additional experiments to fully
quantify mechanical performance.

We note that our sweating strategy incurs penalties in FEA performance. Particularly, the presence of

the pores can mean that the material fails to maintain large pressure differentials during fluidic
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Fig. 2 | Characterization of smart pores. a, Experimental setup for pore analysis. b, Representative images of porous
hydrogels at different temperatures. Portions of this figure are reproduced with permission from ref. .

actuation (Fig. 2). To quantify this inefficiency, we recommend printing an identical non-sweating
actuator (i.e., without pores) and repeating these measurements for comparison.

23

24

25

26

27

Couple fluidic tubing (Tygon, 3.175-mm o.d., 1.58-mm i.d.) to the actuator’s inlet. We found it
easiest to create a leak-free seal by applying a liquid adhesive to the tubing before insertion. Both
cyanoacrylate glue and excess hydrogel resin (with subsequent UV exposure) are suitable adhesives.
A CRITICAL STEP The hydrogel actuators are often very delicate and tacky. During this process,
handle the actuator gently and use non-stick surfaces, where possible.

Secure the base of the actuator assembly to a stand such that the actuator can bend freely. As shown
in Fig. 3a, we 3D-printed (Carbon M1 printer) stands and chassis out of rigid commercial materials
(Carbon urethane methacrylate) to both mechanically secure the actuator and provide fluidic
routing in the multi-fingered devices (see Supplementary Figs. 3 and 4 for design schematics and
refs. “>*"). Then, set up a high-resolution digital camera (Canon EOS 80D, 24.2 megapixels) with a
field of view that captures the entire range of motion of the actuator.

Connect the fluidic control equipment. We built a volumetric control system by using a syringe,
pressure sensor, manual on/off valve, syringe pump (New Era Pump Systems Inc. NE-1000) as
shown in Fig. 4. When attaching the system to the Tygon tubing, we recommend a syringe with a
Luer lock connection and the appropriate coupling hardware.

Use LabVIEW software to control the syringe pump while simultaneously monitoring the pressure
sensor and video recording the actuator motion. We collected these data while injecting fluids at a
rate of 5 ml/min.

Analyze the bending angle as a function of actuation state (volume and pressure). To enable rapid
processing, we developed a separate program in MATLAB. The full code is available in
the Supplementary Information; briefly, this program first imports the video in MATLAB and
separates each frame. Next, in each image, the algorithm detects the top and bottom edges of the
actuator (Supplementary Fig. 5). The program automatically measures the angle between a line of
interest (i.e., the top edge) and a reference line (i.e., the bottom edge at t = 0).

A CRITICAL STEP Avoid bursting the thin walls of the actuator by over-pressurization.

Thermoregulatory performance of sweating actuators

A CRITICAL Fabricate a geometrically identical but non-sweating actuator by removing the pores from
the design. The purpose of these steps is to find out whether perspiration occurs when the material is
hot, and whether this perspiration results in cooling.

28

Begin by equilibrating the actuator assembly, including the water reservoir in the syringe, at an
elevated temperature. This step minimizes any thermal gradients within the body and surface of the
actuator at the start of the experiment. Perform the sweating tests, first on the single actuator and
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Robotic grippers

Actuator stand

Finger
actuator

e

chassis c .
Gripper chassis

Handle -

Palm
cover

Mw

Sweating hand

Fig. 3 | Robotic systems for performance testing. a, Single actuator assembled in a 3D-printed stand. b, Anthropomorphic soft hand. ¢, Robotic
three-point gripper.

IR camera,

PC with LabVIEW

i Data acquisition setup

Actuator mount
(optional)

Hot plate

Syringe pump

Leuer lock syringe
Tygon tubing

Pressure sensor

Fig. 4 | Experimental setup for mechanical and sweating tests.

then on the anthropomorphic soft hand (see Fig. 3a,b and Supplementary Figs. 6-9c¢ for the design
schematics and reference °°).

!CAUTION Use appropriate protective gear (oven mitts and tongs) to avoid damage from
manipulating hot objects.

A CRITICAL STEP Conduct these experiments in a controlled environment. Particularly, reduce
erratic convective currents and maintain a constant temperature and relative humidity. Minimize
conductive losses by mounting the actuator on a stand (see the Supplementary Information and
design files").
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29

30

31

32

Similar to the procedure described above (Mechanical performance of actuator), secure the actuator
assembly within the field of view of a thermal camera (Fig. 4).

A CRITICAL STEP Maintain a consistent distance between the actuator and the camera. In our case,
we kept this distance within 100 + 10 cm.

A CRITICAL STEP To accommodate for passive cooling during experimental set up, it is
recommended to equilibrate at a higher temperature than the desired experimental range.
Working safely but rapidly also mitigates these unintended losses. We observed a temperature loss
of ~3-5 °C during setup.

Again, using the LabView program, start the syringe pump at a constant flow rate and immediately
begin recording the actuator with a thermal camera. Depending on the camera, this can either be
continuous video footage or periodic images at short time intervals (i.e., t = 15 s).

A CRITICAL STEP When taking periodic images, ensure that the metadata or the field of view
contains timestamps.

Continue recording the actuator performance as needed, or until the body temperature reaches
ambient. Repeat as necessary for statistical significance (n > 3).

Fabricate a geometrically identical but non-sweating actuator by removing the pores. Repeat Steps
1-4 to generate a comparative data set. Similarly, this protocol enables assessment of designs with
different pore shapes, sizes or densities.

Thermography under forced convection (optional)

A CRITICAL The purpose of these steps is to find out how cooling is influenced by the rate of
convection. This is done by using a fan to experimentally create sufficient ,forced convection’, to
dominate any contribution from ‘free convection’.

33

34

Place a fan (Honeywell HT-900) parallel to the sweating plane of the actuator and ensure that the
resulting air current encompasses the entire actuator area.

Maintain a consistent, known wind speed (e.g., fan setting 1, wind speed = 5.3 m/s) and repeat
Steps 1-5 above. In total, at least four thermography data sets should exist: (i) free convection,
sweating actuator; (i) free convection, non-sweating actuator; (iii) forced convection, sweating
actuator and (iv) forced convection, non-sweating actuator.

Thermal manipulation by robotic sweating gripper

A CRITICAL Eluting moisture from within the robotic body may lead to more advanced functions,
including thermal manipulation of objects. To quantify the ability to cool down gripped objects, we
recommend performing the following steps.

35

36

37

Assemble a sweating robotic gripper. This can most easily be done by affixing numerous 3D-printed
finger-like actuators (see Fig. 3c above and Supplementary Figs. 10 and 11 for design schematics
and ref. *’) onto a chassis that properly aligns the ‘fingers’ and the associated fluidic controls (inlets,
tubing, etc.).

Thermally equilibrate the gripper and the desired object at the desired elevated temperature. The
thermal imaging camera can confirm equilibration.

Similar to Thermoregulatory performance of sweating actuators above, use the FLIR camera to
record the manipulated object and the sweating robotic gripper from a constant distance (i.e., 100 +
10 cm) over a period of time. For comparison, conduct the same experiment with a non-sweating
equivalent gripper.

A CRITICAL STEP Ensure that the manipulated object possesses a similar emissivity to that of the
soft robotic gripper (¢ ~0.95). The use of surface coatings (e.g., paint) can alter emissivity.

Analysis of thermographic images

38

39

40

After finishing the above experiments, upload the images onto a computer. FLIR cameras
simultaneously take thermographs and optical images. In a thermographic image, each pixel is
assigned a color on the basis of the measured temperature from its IR spectrum.

Import the images into image analysis software. We recommend the FLIR Tools software. Within
this application, we chose to view the data as FLIR MSX (Multi-Spectral Dynamic Imaging) to
enable greater clarity of object edges and boundaries. This proprietary format combines each
thermal image with its corresponding optical image without diluting the thermographic data.
Choose a color pallet for the thermal image (e.g., File — Add — Folder — Image — Palette — Iron
bow). In FLIR Tools, we recommend the Iron bow pallet because it is a general pallet ideal for
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identifying thermal anomalies and body heat. Further enhance the contrast in the image by right- 581
clicking on the image and selecting ‘Color Presentation’. The ‘Histogram Equalized’ option provides 582
the largest contrast by removing unused colors from the color scale. 583
A CRITICAL STEP By default, FLIR Tools software uses a dynamic color scale that depends on 584
the maximum and minimum temperature in the field of view. As the actuator cools, the maximum 585
temperature often drops, which alters the default color scale and prevents obvious comparisons 586
made between images. To aid in visual comparisons, manually define the maximum and 587
minimum temperature in the color scale for each image as the overall maximum and minimum 588
temperatures observed across the entire experiment (File — Add — Folder — Image — Color Bar 589
— Max/Min). 590
41 Record the appropriate experimental parameters for the thermal image acquisition. In our example 591
above, we recommend the default setting: emissivity, ¢ = 0.95; relative humidity, RH = 50%; 592
reference temperature, RT = 20 °C; and distance, d = 100 cm. 593
42 With the object’s features well defined, select an area of interest with the appropriate selection tool 594
(rectangular box or elliptic shape). The FLIR software calculates the maximum, minimum and 595
average temperature of pixels bound by the selection. For quantitative analyses, we use the average 59
temperature. 597
A CRITICAL STEP Choose an ‘area of interest’ that is consistently visible in all images and 598
sufficiently representative of the body temperature. In some cases, especially when the robotic body 599
is bent, it can be difficult to use a single polygon or ellipse to cover the area of interest. We 600
recommend using multiple polygons to extract the accurate temperature profile over the entire area 601
of interest. 602
43 Repeat as necessary for each thermal image. Record the average body temperature and the time of 603
image acquisition to generate the time-temperature dataset. This protocol assumes that the surface 604
temperature is representative of the body temperature. The resistance to heat transfer within the 605 K&E
body must be much less than the resistance to heat transfer from the body to the environment; this 606
assumption is valid for small Biot numbers (Bi < 0.1). When estimating the Biot number, use ASTM 607
E1952 (Test Method for Thermal Conductivity and Thermal Diffusivity by Modulated Temperature 608
Differential Scanning Calorimetry) to measure the thermal conductivity of the actuator. 610

Estimation of cooling capacity from thermography 611
A CRITICAL Animal physiology literature often compares thermoregulation in terms of cooling power 612
per unit body mass (W/kg). Unlike the methods used in animal physiology experiments (described in 613

the Introduction), which incorrectly attribute all water loss as productive evaporative losses, our time- 614
temperature data permit direct estimation of the cooling power. The flow of heat from a body results in 615 K22
a drop in body temperature according to Eq. 1. 616

. dT

= mc, — 1

Qiotal p dt ( )
Where Q is the instantaneous heat transfer rate (W), m is the mass of the system (kg) and ¢, is the 618
specific heat (J o kg*1 «°Ch. 619
44 Identify a temperature range (T;-T,) consistent with all trials from the thermographic data. 620
45 For each dataset, determine the times (#; and #,) that correspond to these temperature values. 621

A CRITICAL STEP When making discrete thermographic measurements (i.e., thermal images and 622
not thermal videos), there can be gaps in the time-temperature data that prevent an exact 623
thermograph corresponding to the desired points (¢, T). Here, we recommend using the adjacent 624

data points (¢; > ¢ > ;) to linearly interpolate an estimate of these values. 625
_ (=)
t=ti+ (f— 1) * =)
or (2)

T=Ti+ (1~ 1)« (=

-
ti—tj)

627
46 If unknown, measure the specific heat capacity, c,, for the materials following an appropriate 628
measurement protocol such as ASTM E1269°". 629

A CRITICAL STEP For multimaterial construction, measure the specific heat capacity of each of the 630
base components. Estimate the effective heat capacity as a weighted average (by mass) of the 631
individual heat capacities. Include the pressurizing fluid in these calculations. 632
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Troubleshooting

47 From the time, temperature and specific heat data, calculate the cooling power by using
Eq. (3) below.

Q_o[h-T)]
m [tz — tl]

Cooling Power (g) = (3)

A CRITICAL STEP This estimate captures all modes of heat transfer (conductive, convective,
radiative and evaporative). To isolate the contribution from sweating, subtract the cooling power of
an equivalent non-sweating actuator.

Lumped parameter analysis

A CRITICAL According to Newton’s Law of Cooling, the rate of heat flow depends on the device
geometry and the thermal gradient between body temperature and that of the ambient environment
(T,). Thus, comparisons between instantaneous cooling rates are valid only over similar experimental
conditions. To enable quantitative comparisons across experimental trials (e.g., to compare cooling
capacities of different machines or starting temperatures), we propose the use of a ‘lumped parameter’.
For a more thorough justification of this derivation, see the previously published report’*~*.

ar

dt
where b is our lumped parameter. We impose the boundary condition that T'= T, at ¢ = 0. Solving
this first-order differential equation yields the analytical model (Eq. 5):

T(t) = (To — Tp)e ¥ 4+ T, (5)

- _b(T_ Ta) (4)

Newton’s Law of Cooling holds only for certain situations, like forced air-driven convection with a
constant heat transfer coefficient. To date, there is no multiphysics model that could simultaneously
describe this system’s conductive, radiative, convective and evaporative modes of heat transfer. As such,
the lumped parameter, b, does not carry any phenomenological meaning—it merely quantifies an
equivalent idealized scenario, where the cooling rate is linearly proportional to the temperature gradient.
48 Identify a consistent T, from the experimental data. Ideally, choose the lowest initial ‘average body
temperature’ found among the different trials. Because body temperature is a state function, this
ensures that the range of data will overlap.

49 For each dataset, determine the starting time (t,) that corresponds to this T, value. Appropriately
shift the time values in the dataset to such that ¢, = 0.
A CRITICAL STEP Again, discontinuous sampling may preclude direct observation of the desired
initial data point (#y, T,) across all trials. Similar to the above (Eq. 2), for the chosen initial body
temperature (Ty), interpolate the appropriate starting time (t;) from the neighboring values.

50 Plot T versus t and fit the data for an exponential decay according to Eq. 4 above. Extract the
lumped variable, b. If desired, determine the R value of these fits more than 0.96.

51 Repeat for the other experimental conditions. When comparing systems, higher lumped parameters
indicate increased cooling rates.

Troubleshooting advice can be found in Table 3.

Table 3 | Troubleshooting table

Step Problem Possible reason Solution
5 Obiject failing to print Underpolymerization Increase photo-exposure dosage by 10% and
reprint. For any alteration to the resin’s
composition, we recommend generating a new
working curve
Loss in z-axis resolution, Overpolymerization Decrease the photo-exposure time by 10% or
excessive cure-through, add non-reactive absorptive species

printer jamming

(nanoparticles or dyes). For any alteration to the
resin's composition, we recommend generating
a new working curve

Table continued
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Table 3 (continued)

Step Problem Possible reason Solution
A printed part is breaking or Mechanical translations during Realign the part such that the principle axes are
deflecting during printing printing are greater than the yield parallel to the incident forces (i.e., translations
strength of the part of the build head)
A printed part exhibits poor The active free species diffuses Increase the amount of radical scavenging
x-y resolution but maintains beyond the photo pattern; it usually species (hydroquinone). In addition, increasing
acceptable z-resolution coincides with an increase in resin the wait period (ModelPressWaitMS) or the
viscosity over the print process z-axis separation (ModelZLiftMicrons) between
layer exposures helps drain partially cured resin
from within intricate features
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Fig. 5 | Dynamic response of hydrogel pores. a, Dimension change of PAAm-based pores of different diameters in
response to temperature. b, Reversibility of hydrogel response in favorable and unfavorable conditions. Error bars
represent the standard deviation (n > 7). Reproduced with permission from ref. *.
Timing
Steps 13-18, characterization of smart materials for autonomic pores: ~24 h
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Fig. 6 | Performance of sweating actuators. a, An actuator pressurized to different actuation angles and sweating. b, The temperature change of
sweating (dashed lines) and non-sweating (solid lines) actuators under both free (black) and forced (red) convection modes. Shaded regions
represent the range of temperature over three trials. ¢, A robotic hand composed of sweating actuators rapidly thermoregulating via perspiration.

Anticipated results

674
This protocol outlines the design and manufacture of FEAs that perspire. Stereolithographic printing 675
of hydrogel chemistries yields bioinspired soft robots with dynamic micropores that autonomically 676
dilate and contract in response to temperature. As shown in Fig. 5a, appropriate material selection 677
and design should yield pores that exhibit a significant change (>25%) in cross-sectional area with 678
temperature. For stable autonomic operation, this dimensional change should be reversible. As shown 679
in Fig. 5b, our hydrogel system is capable of undergoing numerous dilation and contraction cycles 680
between favorable (water, 25 °C) and unfavorable (non-solvent) conditions. 681

In Fig. 6a, we showcase an example actuator printed according to the above protocol and pres- 682
surized to obtain different actuation amplitudes during perspiration. In Fig. 6b, we measured the 683
surface temperatures for these sweating actuators (solid lines) and their non-sweating actuators 684
(dashed lines) in an environment with free convection (black lines) and forced convection (red lines). 685
Our perspiring finger-like actuators initially cooled up to 39.1 °C/min under forced convection (wind 686
speed = 0.165 m’/s), whereas the same non-sweating variant dropped only -5.75 °C/min over the 687
same conditions. Through this comparison, we estimate that perspiration increases the effective 688
lumped parameter, b, by 0.102, which corresponds to a 1.6-W increase in cooling capacity. 689

Researchers can perform sanity checks to verify the feasibility of their measured perspiration-based 690
cooling capacity by crudely tracking the water economy. The water loss rate (ml/s) multiplied by the 691
molar density of water (55 mmol/ml) and enthalpy of vaporization (~40.65 kJ/mol) yields the 692
maximum possible heat loss from evaporation only (W). Our results above (1.6 W of CEWL from 693
sweating) suggest an evaporative water loss of ~0.04 ml/min, a plausible value that is consistent with 694
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Fig. 7 | Thermo-manipulation of grasped objects. a, A polyurethane foam object passively cooling in air. b, The same
polyurethane foam object rapidly cooling because of secreted perspiration from the robotic gripper composed of
sweating actuators.

empirical observations. For large-scale systems, tracking the volume of water in the internal reservoir
or the overall mass of the system could provide direct measurements of the water loss rate. Liquid
water probably leaves the surface of the actuator before evaporation; this water loss is not productive
for thermoregulation. Modifications to surface texture, pore density, pore distribution, etc. can reduce
this inefficient water loss.

However, these water droplets that fall from the actuator’s surface can be used to cool their
surroundings to enable thermo-manipulation. In Fig. 7a, a polyurethane foam object is shown
passively cooling under ambient conditions. By comparison, in Fig. 7b, the same object is being
thermo-manipulated by a robotic gripper composed of perspiring actuators. The secreted water from
the gripper rapidly cools the surface of the object, to improve cooling rates by >200%.

Reporting Summary
Further information on research design is available in the Nature Research Reporting Summary
linked to this article.
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